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High Bandwidth Memory (HBM)

wes> SKA Low Correlator & Beamformer

®* HBM is a new type of memory chip.

® \Vertically stacked memory chips
interconnected by Through Silicon
Vias (TSV).

® Low power consumption.
® Ultra wide communication lanes.

® Faster speed.
® Less Area.

PHY FPGA
SEEE & B BB

Package Substrate
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Stacked Silicon Interconnect
(SSI)

« 3-D Packaging approach

« Combines multiple Super Logic
Region (SLR) components
mounted on a passive Silicon
Interposer.

High-Barndwidth
Lowi-Latency Connactions

* SLR contains

. Input LUTs, Registers, I1/O
components, Block Memory, DSP
blocks, etc...

* Multiple SLR components are
stacked next to each other to
create the SSI device.

Mecrobsamps
Through Sdcon Vias (TSV)

CA Bumps

14th February 2019 - C4SKA @ AUT 3



A :.-,;;,g’: .
74 perentie

E
Hagged™ SKA Low Correlator & Beamformer

FPGA with HBM

Virtex Ultrascale+ xcvu37p

FPGA Slice

FPGA Slice

HEM DA Balls

®* HBMis added as a slice.
® SLRO serves as a master.

®* HBM comes with DA ports which have to be
routed to BGA balls.
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HBM in virtex ultrascale + »"
devices Jzperentie
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32 Gb HBM Stack 32 Gb HBM Stack

* Divided into two 1024-bit wide HBM stacks.

« [Each stack is split into eight independent memory channels.

« Each Memory channels has two 64-bit pseudo channels.

- Each memory channel can be operate at an independent clock rate.
« AXI3 Protocol is used.

« Ithas a16 x 16 AXI crossbar switch.
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Basic AXI transactiton

 The AXI (Advanced eXtensible Interface) is
a point to point interconnect that designed
for high performance, high speed
microcontroller systems.

» It avoids bus sharing and therefore allow
higher bandwidth and lower latency.

 The procedure for the AXI protocol is as
follows:

« Master & slave must “handshake” to confirm
valid signals

 Transmission of control signal must be in
separate phases

« Separate channels for transmission of signals

 Continuous transfer may be accomplished
through burst-type communication
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To Read

Read Address

r
ARREADDY

Head data

1
RREATY

To Write

Write Addmess

Wirite Dty

WREADY

Write Response

DREADY




AXI HBM Customize IP - HBM S

ﬁ{,‘-
- - - . f1perentie
Configuration Selection Tab VU £t

HBM Configuration Selection Example Design Options | Address Map Options | Reorder,Refresh and Power Savings O 4 b =

Component Name hbm_0
HEM Density 4GB ~ Select Stack | LEFT ~
Total Available Memony{ME) 4096

[+] Enable Switch 0/Global Addressing Stack 0

Enable & Configure all MCs to Same Value? yes ~

Memory Clocking
HBEM Memory Frequency for Stack0 (MHz) 9S00

PLL Reference Input Clock 0 (MHz) 100 v

APB Clocking
APE Interface 0 Clock (MHz) 100 =

@

Temperature Polling Interval on APB-0 (ms) 1.0

Select MC's to Enable for Stack0 @

MMco MMC1 MMc2 MMC3I PMCa MMCS MIMCE MMCT

Select AXl Slaves to Enable for Stack 0 @
¥ sma 00 saxi o1 Msano02 Msaao3 #saaos #saaos M saxos M sax o7

V) SAX_08 M) SAXI_09 WSAXI 10 MSAa 1l WM SAa_12 W SAM 13 M SAax 14 M SAXI 1S

Switch Clock Select 0 @
Clock Select 0 | AXI 07 ACLK  w

Select Line Rate for each MC of Stack 0 @
MCO  div4 “
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AXI HBM Customize IP - HBM 5=
Configuration Selection Tab W ki

HHHH HHHH HHHH PPﬁ‘i%“ﬂa"?‘FWP??‘%‘HHHH PREA it phatitet

|« Enable Switch 0/Global Addressing Stack 0 |
Enable & Configure all MCs to Same Value? yes v M1C . W W W ﬁ . .

Memory Clocking . ..-2!
b|b b|b b|b b|b b|b b|b b|b
HBM Memory Freguency for StackD (MHz) 900 !

K .‘.'.-,‘8'3-.

a-nru
TonH

PLL Reference Input Clock O (MHz) 100 v
APB Clocking
APB Interface 0 Clock (MHz) 100

Temperature Polling Interval on APB-0 (ms) 1.0

Select MC's to Enable for Stack0
| MC O MC1 MC 2 MC 3 MC 4 MC 5 MC 6 MC 7

Select AXI Slaves to Enable for Stack 0
# saa 00 Misaxol Msaao2 Msaao03 Msaaos Msaxos M saaos M sax o7

V) SAN_08 P SAaxI 09 B SAM 10 BSAX 11 MSAana 12 B SAXI 13 [ SAX 14 A SAX 1S

Cusitrh Fladk Calact N
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AXI HBM Customize IP - HBM
Configuration Selection Tab

[ Enable Switch 0/Global Addressing Stack 0

Enable & Configure all MCs to Same Value? yes v

Memory Clocking @
HBM Memory Frequency for Stack0 (MHz) 900

PLL Reference Input Clock O (MHz) 100 W

APB Clocking @
APB Intarfaca 0 Clock (MHz) 100

Temperature Polling Interval on APB-0 (ms) 1.0

Select MC's to Enable for Stack0 €3]
| MC 0O MC1 MC 2 MC 3 MC 4 MC 5 MC & MC 7

Select AXI Slaves to Enable for Stack 0 ®
V) SA0 00 ) sax 01
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AXI HBM Customize IP - HBM p T8 y
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Configuration Selection Tab

|_| Enable Switch 0/Global Addressing Stack O

Enable & Configure all MCs to Same Value? yes “
Memory Clocking &
HBM Memory Frequency for Stack0 (MHz) 900
PLL Reference Input Clock O (MHz) 100 w
APB Clocking @
APB Interface 0 Clock (MHz) 100

Temperature Polling Interval on APE-0 (ms) 1.0

Select MC's to Enable for Stack0 @
| MC O MC 1 MC 2 MC 3 MC 4 MC S MC 6 MC 7

Select AXI Slaves to Enable for Stack 0
v saa 00 [ sax 01
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AXI HBM Customize IP - HBM e
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Configuration Selection Tab

HBM Configuration Selection Example Design Options Address Map Options Reorder,Refresh and Power Savings O P =
Component Name hbm_mco <
HBM Density B8GB v

Total Available Memaory(ME) Bl192

[+ Enable Switch 0/Global Addressing Stack 0
|| Enable Switch 1/Global Addressing Stack 1
Enable & Confiaure all MCs to Same Value? ves v

Select MC's to Enable for Stack0 @
VMO MMC1 MMC2 MMC3I MIMCA MIMCS MIMCE MIMCT

Select MC's to Enable for Stackl @
VIMce MMCo MMClo MIMC11 MIMC12 MIMC13 #MC1l4a M MC1S

Select AXI Slaves to Enable for Stack 0 @
¥) SAX_00 [ sax 01 ] sax 02 () sax 03 ) SAx 04 ) sax 05 ¥ Sax 06 ) sax_07

V) SAXI_08 ) SAX_09 M) SAX_10 #)saX_ 1l M SAM 12 MsaX 13 M SAX 14 ) SAX_1S

Select AXI Slaves to Enable for Stack 1 @
V) SAXI_16 ) 5AX 17 W SAX_18 M) S5aX 19 W) SAX 20 ) 5ax 21 ) SAx 22 ) 54X 23

V) SAXI_24 ) SAX 25 W SAXI_26 ©)SAX 27 W) SAXIL28 B SAXI 29 ) SAX 30 ) SAX 31
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AXI HBM Customize IP - HBM >

perentle

Configuration Selection Tab

negal | i

22 22 22 22 22 22 22 z
G |G GG G|G G|6 G|G G |G G|e G
b|b| |b|b b|b||b]|b b|b||b]|b b|b b

Select MC's to Enable for Stack @&

u-nru

FIMCO [(Mcl [Omc2 [Omc3z [OMmc4 [OMES [JMEs [(JMC7

Select MC's to Enable for Stackl O]
MC 8 MC S MC 10 MC 11 MC 12 MC1l3 [ JMC1l4 MC 15

Select AXI Slaves to Enable for Stack 0
| SAXI 00 ) SAXI 01 ») SAM 02 »)SAXNI 03 | SAXI 04 v 5AX 05 v SAM 06 ) SA 07

/) sax 08 M saxios Msaalo Msanll Msax 12 Msax 13 M saalsa M sanls

Select AXI Slaves to Enable for Stack 1 ]
V) SAM 16 MISAX 17 MSAX18 MISAXI 19 MSAM 20 M SAX 21 M SAx 22 W sax 23

V) SAXI 24 ) SAXI 25 B SAXI 26 M) SAXI 27 W) SAX 28 ©)SAXI 20 ) SAXI_30 W SAXI 31
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AXI HBM Customize IP - HBM v
Configuration Selection Tab

EE negal | i

22 22 22 22 22 22 22 z
G |G GG G|G G|6 G|G G |G G|e G
b|b| |b|b b|b||b]|b b|b||b]|b b|b b

u-nru

Select MC's to Enable for Stack0 @&

FMco [(OmMmcl OmMmcz MMmc3 [(Omca [Jmcs [Omcs [OJmMc7

Select MC's to Enable for Stackl &
MC 8 MC S MC10 W MC1ll W MCLl2 MC 13 MC 14 MC 15

Select AXI Slaves to Enable for Stack 0 @
& SAX1 00 ) SAX| 01 »)SAX 02 ) SA 03 v SA 04 W SAXIOS [» SAXI 06 W SAX 07

| SAXI 0B ] SAXI 09 I SAN 10 W SAXI 1]l WISAMI 12 » SAXI 13 ) SAN 14 @ SAXI 1S

Select AXI Slaves to Enable for Stack 1 ®
VSR 16 M Sax 17 MISsan18 MSaX 19 P saa20 P san21 M saa 22 & san 23

L

V) SAX 24 M SAXI 25 )SAXI 26 #)SAX 27 W SAX 28 o SAXI 29 SAX 30 ) SAXI 31
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AXI HBM Customize IP - HBM
Configuration Selection Tab

nfiguration Selection | Example Design Options | Address Map Options | Reorder,Refresh and Power Savings Options 4 »

MCO @
Traffic Options ®
Select Traffic Pattern  User Defined

Re-order Options @
& Enable Request Re-Ordering

! Enable Coherency in Re: When enabled, 4X] commands in a moving window of up to
64 entries are reordered to optimize performance.

Re-Order Queus Age Limit Ox7T i |

Re-order Options

1 Enable Request Re-Ordering

#* Enable Coherency in Re-Ordering

Re-Order Queue Age Limit when enabled, prevents commands addressing same
memary row and bank from being reordered. This feature
Enable Close Page Reorder ensures state of memaory is only dependent on order of

commands received from AXI master and are not affected by
& Enable Lock Ahead Pre-Charge command reordering.
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Basic settings required to run e
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Settings

8]

» Supported simulators: Modelsim,

Simulation

Pn;ied slguinqs Specify various settings associated to Simulation ' Questasim, IES and Verilog Compiler.
Simulation Target simulator: MaodelSim Simulator ~ . - .
oo i : « Change the Compiled library location to
b Simulator language: Mixed v R . . .
ik P = v the location of the compiled library in the
: :E:tst’earn Simulation top module name: ctf hbm_buffer_ram |‘ installation area.
| T P Ccompiled library location: ‘home/fopt/Mentor/SE_10.6b/XILINX_LIE_2018.3 m
00l ettings E - - -
W e * In the Simulation tab, in the
; |P Defaults Compilation Elaboration | Simulation Netlist = Advancec . . . .
ey = modelsim.simulate.vsim.more_options
isplay verilog options: - .
\[:JZE::-,Ik Generics/Parameters options: “ enter +n0tlmanCheCK'
Help R
y Text Editor maodelsim.compile.tcl. pre i For Questa slmulator, add
e — +notimingchecks in Compilation tab
Selaction Rules modelsim.compile.load_glbl v questa_compile_vlog_more_options and in
Shortcuts modelsim.compile.vlog.more_opti...  +notimingchecks . .
> Strategies modelsim.compile.vcom.more_opt... the SImUIatlon tab
¢ ey questa.simulate.vsim.more_options.

» Window Behavior
* For IES simulator, add -notimingchecks in
the Elaboration tab
ies.elaboration.ncelab.more_options.
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Basic settings

required to run

_Fhe simulation

Project Settings
General
Simulation
Elabaration
Synthesis
Implementation
Bitstream

» P

Tool Settings
| Project
IP Defaults
Source File
Display
webTalk
Help
> Tewt Editor
3rd Party Simulators
» Colors
Selection Rules
Shortcuts
» Strategies
> Remote Hosts
» Window Behavior

?

Settings =TI
Simulation
Specify various settings associated to Simulation '
Target simulator: ModelSim Simulator v
Simulator language: Mixed v
Simulation set: sim_1 v
Simulation top module name: ctf_hbm_buffer ram ‘ . |
compiled library location; ‘home/opt/Mantor/SE_10.6b/XILINX_LIE_2018,3 r|

Compilation | Elaboration | Simulation Netlist Advanced

modelsim.simulate.tel. post

modelsim.simulate.runtime* 500ms
modelsim.simulate.log_all_signals

maodelsim.simulate.custom_do

modelsim.simulate.custom_udo

modelsim.simulate.custom_wave_..

modelsim.simulate.sdf_delay sdfmanx v
modelsim.simulate.ieee_warnings ¥
modelsim.simulate.saif_scope

modelsim.simulate.saif

madelsim.simulate.vsim.more_opt... +notimingchecks

“ Cancel Restore.

14th February 2019 - C4SKA @ AUT
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%
%, SOF
Hagged™ SKA Low Correlator & Beamformer

Supported simulators: Modelsim,
QuestaSim, IES and Verilog Compiler.

Change the Compiled library location to
the location of the compiled library in the
installation area.

In the Simulation tab, in the
modelsim.simulate.vsim.more_options
enter +notimingcheck.

*  For Questa simulator, add
+notimingchecks in Compilation tab
questa.compile.vlog.more_options and in
the Simulation tab
questa.simulate.vsim.more_options.

* For IES simulator, add -notimingchecks in
the Elaboration tab
ies.elaboration.ncelab.more_options.
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Performance Measured
(Mco, saxi_00, clk - 450 Mhz)

Sequential access pattern (read and write) Sequential write and Random
read access pattern
Burst Len
Throughput (Gbps) = write only Throughput read only Throughput Throughput
(Gbps) (Gbps) (Gbps)

1 24 (20%) 54 (47%) 54 (47%) 18  (15%)

(12Rd + 12Wr) (9Rd + 9Wr)

2 42  (37%) 106 (92%) 105 (91%) 24 (20%)
(21 Rd + 21 Wr) (12Rd + 12Wr)

4 50 (43%) 107 (93%) 105 (91%) 46  (40%)
(25 Rd + 25 Wr) (23Rd + 23Wr)

8 84 (73%) 107.2 (93%) 105 (91%) 80 (69%)
(42 Rd + 42 Wr) (40Rd + 40Wr)

16 106 (92%) 107.2 (93%) 105 (91%) 104 (90%)
(53 Rd + 53 Wr) (52Rd + 52Wr)
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Simulation result for Sequentlal
access patternu MB of data, Burst length = 16)

hbm_clk
apb_clk
hbm_rst

b_write_count
r_read_count

# throughput

{{33'h0000...
{33'h0000F...
{33'h000OF...
{256'h0000...
1
1

011 {{256"..

0

1

1
{256'h0000...
256'h00000...
6'h00

o

2'h0

1

{6'hoo} {2'...
32'h7D0
32°h793
54.8519

SKA Low Correlator & Beamformer

o . 1
o L .

{{0000FACDO} '1¥ {oa} {FT {510t {{0000FACOO} {1Y{00} {Ft {S5F 0}

[{00D00000D00000D000000

1{0000FAQDDE {1} {00} {FF {5t O

{0000FADDOY {1} {0} {F} {5t O

{00D0000000000000000000000000000000000000D00000D0D000)000000FADD0YT O {FFFFFFFEL O

foot ot o

1D0

i
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L . - . g . . - g .
Y- 2 5
~ . - . - = -a . = Y o orre or & o)
- J ors l - ) 0
‘  hbm_clk 1 |
“ apb_clk 0
“  hbm_rst 0
&7 axi_00_in {{33'h000ODFCO... 1 {{ooooDzabo} I I I 00f {EE {51 OF 1{0000FADD
B ar {33H0000DREOONN | /0000034001 { NN aRImesenan [ 0] TN (X £ X0
0’ aw {33'R0O000FADBORS] {000CFADC {ooY {F1 {510 ! 1
0w L2568 H0000BORONN 100000(0000000000000« 300 FA000T 0 [FFFEFEFEL
- _rready 1
“ bready 1
87 axi_00_out 011 {{256'ho0... | 41 BN I O . Y Y OO —
“ _arready 0
*  awready 1
¢ wready 1
B {256'hoooooooo. | I U1 M (0oooo . &6 & & & W & EpLmn
0 data 256000000000 ) I 41 M 0000000000, TN T Y | S Y S 000000
B’ id 600 T i | i i i j '
- last 0
B8 resp 2'ho I 1 [
Lot yalid 1
£’ b {16'h00} {2'hot 0 | {00t [0 . | Z
¢ b_write_count 32'h7D0 7D0
¢ r_read_count 32'h79E ] TAD T T Ty ] [TYTTITTITIN] [T FYTTITE TIT TYTTIT (ool
g : | ]
4 Yo (] U / N\ (O A O



0 = 0 P olo = o )
(B 5 5
- . . - - - . - - 0 orrelator & Be orme
510 s - = = D 4
-
4 hbm_clk 0 |
# apb_clk 1
* hbm_rst 0 |
&’ axl 00 in LIS R0000NN ({7 :
‘ ar (33 HO0000RSN XX T{000000)
4 aw {33'h00008... | [xx _ ) (00 200800 ]
0 addr 33'h0000B48B0| » < = A 1 0003010800
g burst 2h1 A [ '
 id 6'hoo X [i[i] 1
B’ ln ah3 X @ [
B’ size 3hs X g |
N —I
4w L256'h0000N N XX .. .. Y (000000000000
I’»—’ rready 1 |
-’ bready 1
& axi 00 out TON{2560 0 0
- arready 1
- awready 0
" wready X
&’ {256'hXXXX. .
:--* data 256 hXOXXK...
4 6'hXx
- last X
- resp 2'hx
¢ valid 0
0’ b {6'h00} {2'...
“  b_write_count 32'h168E
* _r_read_count 32'h0
¢ throughput 0
“  block_write_cou...[32'ho
¢ read block_cnt  |32'ho
4 ebrua 019 4 A @ A 0



and Sequential write pattern

(Block size = 1MB , Burst length = 16)

t 1 [

EiIIEEIIRNIEE

treLt it (IRl i (i (L FEEE I S

Pl { [

ti O O { {1 ([ T {

1_
y

b_write count R — RN

[EEE {f [

r_read count 0 I I 1 I I | i
throughput [

block_write_cou...

read_block_ent
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Questions / Discussion?
Thank-you!
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